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Hear ye, hear ye! The 2012.08 maintenance release of 32bit PCLinuxOS KDE and 32bit PCLinuxOS Minime
KDE have been released. Both have been produced by Pinoc. Unfortunately, if you want a LiveCD, your only
choice is to download the Minime version, since the full KDE desktop now fits only on a DVD sized optical
medium, with the ISO weighing in at 1,283 MB. Or, you could install the PCLinuxOS LXDE 2012.06 release,
which also fits easily onto a LiveCD.
The latest maintenance release contains KDE 4.8.3, an upgrade from the previous KDE 4.6.x desktop. On the
full KDE version, LibreOffice is also included, along with a whole host of other applications. Minime (with an
ISO weighing in at only 508 MB) is a good choice for advanced users who know what applications they want
installed on their PCLinuxOS installation. This
helps you to avoid having a whole host of
applications you may never use and that you
may not want installed, and that unnecessarily
take up room on your hard drive. Of course, you
can take your pick of the over 13,500 packages
in the PCLinuxOS repository to tailor your Minime
installation to be just how you want it.
Also, due to changes in the KDE desktop from
the old 4.6.x version to the 4.8.3 version, there is
not a “clean” upgrade path to the newer KDE
desktop. To help you out, we’ve published a
couple of “cheat sheets” to help you with the
upgrade of your 4.6.x KDE desktop to the 4.8.3
KDE desktop. While either method by itself will
get you there, some users are reporting success
using a combination of the two approaches. To
help prevent data loss, it is highly
recommended that you backup your data before
attempting the upgrade. Of course, one other
option exists – to reinstall from the freshly
updated maintenance release. If you choose the
latter, be extra sure to backup your data before
reinstalling – or risk losing it altogether.
With the new upgrades and the new ISOs having
been released, most of us will have plenty to do
to occupy our time. So, until next month, I bid
each of you peace, prosperity, serenity and
happiness.

1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

Along the Riverfront Heritage Trail in Kansas City, MO.

Welcome From The Chief Editor
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by OldGuy & OldPolack

OldGuy’s Cheat Sheet

I just wrote a cheat sheet for a few friends who use
the KDE version of PCLinuxOS, and would like
comments referencing any incorrect advice. My
friends are usually older, and at times, need some
hand holding. Ergo, this letter:

Hi Friends of PCLinuxOS,
If you have noticed that your updatenotifier seems
to be stuck in “can't update mode,” it's due to the
switch from the older KDE to a newer version.
Yesterday I did the work required to update, and it
wasn't bad. However, without checking off another
package, some of your widgets may appear as a red
"X." This means a widget can't be found.
Asking some of the members of the forum, I
discovered the fix and it's very simple.
Here is what I did to insure a successful update.
Backing up your data before any major modification
is always a good rule of thumb. I use LuckyBackup
to backup all my data (home folder) to an external
drive. Then, just to prove I'm paranoid, I create a
LiveCD using mylivecd. You can burn a copy of the
LiveCD to a DVD, or just move it to an external
drive. Of course this is just in case the whole
process goes bloomers up. And reinstall.
If you just moved the iso to an external drive you will
have to burn it first for the reinstall.

Next, modify the repository information in Synaptic.
Close all windows first, then open Synaptic. When
the Synaptic window opens, go to Settings >
Repositories. Highlight the repository your use (for
me that's heanet.ie). When highlighted, you will see
a line in Sections that reads:
main updates nonfree kde4 games special
Change it to read:
main updates nonfree kde games special
Click OK, then click reload.
Select “Mark All Upgrades,” and be sure that "kde
plasmaaddons" is also selected. If it isn't, check it
for installation. If you leave it unchecked, it could be
the cause for the missing widgets in your panel.
Take a stiff drink, and press apply. After it’s
complete, reboot your machine.
All done.
Now you should be ready with the newest version of
KDE. Should your desktop be different (and I'm sure
it will be), there is another icon added that can be
used to bring back your older widgets. Click on the
"RestoreMyDesktop" icon.
After restoring, you can safely delete the
"RestoreMyDesktop" icon from your desktop.
Note from the forums: RestoreMyDesktop is a
backup of your desktop settings before you updated.
Once you make changes on your current desktop,
these new changes will not be moved to restoring
your previous desktop settings. RestoreMyDesktop
is best used immediately.

I didn't bother with RestoreMyDesktop, since I have
only one extra widget on mine. I just added it to my
desktop, and changed the way time/date is shown to
show the day and date. I also use “Hard Disk status”
to show my current disk usage on the desktop.
One warning, though. During my change, I somehow
screwed up my taskbar and everything was
smushed to the left. This was an easy fix. I went to
Synaptic and reinstalled kde4config. That fixed it
right up.
Good luck. Drop me a message in the forum if you
need further assistance, or visit this post in the
forum.

Afterwards, OP posted this ...

The PCLinuxOS development team has been trying
to make the KDE upgrade to the 4.8.3 version as
near to a normal Synaptic upgrade as we have all
become used to. Unfortunately, the KDE developers
have changed a lot of the package names, which
causes insurmountable problems with some
packages when a dynamic/rolling upgrade method is
used. A clear upgrade path simply can't be
established.
The KDE packages are designed for a static release
method of upgrading, where each upgrade means a
complete reinstallation of the entire system, so our
dynamic release system must sometimes accept
slight deviations in our normal procedure to
accommodate situations like this.
Note: Your personal desktop settings may be
changed to the default desktop settings during this
process. If this occurs, a new desktop icon,

KDE Upgrade Cheat Sheet

http://www.pclinuxos.com/forum/index.php/topic,108161.0/topicseen.html
http://www.pclinuxos.com/forum/index.php/topic,108162.0.html
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RestoreMyKDEdesktop will appear, to do just what
it says. A backup of your personal desktop settings
will have been made, and running the
RestoreMyKDEdesktop script will restore your
personal settings from that backup. As an extra
precaution, you may wish to make your own backup
of your/home/<you>/.kde4 directory, or even your
entire $HOME directory, before running the upgrade
procedure.

There will be two methods available to do the
upgrade from KDE 4.6.5 to KDE 4.8.3, only one of
which is currently available. It will require a change
in the Synaptic Settings > Repositories window's
Section(s): box, changing the section kde4 to
simply kde.
If you have aptsourceslist version 1.0.2 currently
installed, or can still install it from your chosen
mirror, it has already made, or will make, the
necessary change for you on all current mirror
entries.
If you do not have aptsourceslist version 1.0.2
currently installed, and Synaptic will not now install
it, for any reason, the following will allow you to
make the change manually, allowing the KDE
upgrade to commence.

In the Synaptic Settings > Repositories window,
click on the currently used active mirror to fill the
lower data entry fields. In the bottom Section(s):
field, if there is currently a kde4 section, place the
mouse cursor directly behind the 4, click, then press
the keyboard Backspace key once, then click the
OK button (top and center, at right).
Click the Reload button, and wait for the package
lists to be updated. At this point, you can continue to
perform the actual upgrade.

Normal upgrade with manual cleanup:
Do the normal Reload > Mark All Upgrades >
Apply > Apply upgrade. If no packages are listed
as broken, proceed as usual. Some packages will be
shown as being removed, without being replaced.
Take note of these package names, for use later.
Which packages these will be will vary, depending
on what is actually installed on any given individual's
system.
When the upgrade has finished, leave Synaptic
open, open a terminal and enter the command:
[<you>@localhost ~]$ rpm qa |grep 4.6.5<Enter>

A list of remaining KDE 4.6.5 packages that were not
upgraded will be presented. Leave the terminal
window open for reference.
In Synaptic, Search for each individual package in
the terminal list and mark it for Removal. When all
are marked, click Apply > Apply.
When finished, again in Search, enter kde and click
the Search button.

Scroll down the results in the upper right pane to find
the package name that most closely resembles the
name of the removed 4.6.5 package and Mark for
Installation. If any package with a similar name
cannot be found, it has been obsoleted and is no
longer needed. When all that can be found have
been properly marked, and the removed but not
replaced packages from the initial upgrade are
also marked, again click Apply > Apply to
complete the package upgrades, then close
Synaptic and reboot.
For most users, the above method works quite well,
even though a bit clumsy in execution.

KDE Upgrade Cheat Sheet
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If you experience difficulties, such as broken
packages being reported, or packages missing
dependencies, those packages should be
unmarked/removed from the upgrade list, so the rest
of the upgrade can proceed. If that still doesn't work,
stop where you are and report the exact problem in
the appropriate forum section, giving as much detail
as you can, then wait for a reply to receive help.
The second upgrade method referred to, at the
beginning of this announcement would be installing,
or reinstalling, from the finalized, reluctantly delayed,
quarterly release ISO image.
The quarterly ISO has been released as well.

Screenshot ShowcaseScreenshot Showcase

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com
We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

The place where breaking news,
BitTorrent and copyright collide

Posted by Crow, August 13, 2012, running LXDE.

KDE Upgrade Cheat Sheet

mailto:pclinuxos.mag@gmail.com
http://pclinuxos.com/?page_id=7
http://www.linuxquestions.org
http://torrentfreak.com/
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by Meemaw

To wrap up our coverage of Linux financial apps,
we’ll take a look at Skrooge. It is available for Linux,
Mac and Windows. The online user guide is here.
When you open Skrooge the first time, the Welcome
window is shown, as follows:

It looks a little like Dolphin to me because of the tabs
at the lower left of the window. I ended up removing
the Properties and History tabs, but you might want
to keep them.
As with the other programs, you must either create
your account file or import it. File formats that are
compatible are OFX (Open Financial Exchange),
QFX (Quicken file), QIF (also a Quicken file) and
CSV. I created my normal accounts, Meemaw’s
Checking and Meemaw’s Savings.
You will also see tabs in the righthand section. This
is handy, since you can have several sections open
at once. You only have to click View > New Tab to
add another, then click the section in the lefthand
column that you desire.

The first thing you see in the lefthand column is the
Dashboard. It is like the Home Page in KMyMoney,
giving you a quick overview of your accounts. As you
add normal and scheduled transactions, along with
your budget, many of the items in your Dashboard
will be items that will interest you or need your
attention when you first open Skrooge. All items can
be removed or added (if they aren’t there already).
To remove an item, you should hover your mouse
over that item and a toolbar will appear. The left end
of the toolbar has a red X, which you can click to
remove that item. Each toolbar also has left and
right arrows to allow you to arrange your Dashboard
in a way that works for you. If you find that you have
removed something in error, a green plus sign at the
top right of the window section will allow you to re
add it.

In the column on the left, we see the additional
following sections:
Accounts
This section shows the accounts you created at
setup. You can also add any new accounts from
here. Using the editing section at the bottom, enter
the important information, then click the Add button.

If you make a mistake, simply correct it, then click
the Modify button. This method is used throughout
the program.
Operations
This section is where you enter all your transactions.
One thing that makes Skrooge different is that in this
window you have to actually enter the outgoing
money using a minus sign (250.00) to designate the
subtraction from your account. Debits to the account
will show in a red font, and credits in black, so if you
enter one incorrectly, you can see it.

After you get a few operations entered, you will
probably start entering the same basic few every
month. Skrooge has a method to make this a little
faster. Enter the Payee or Category for the
operation, then click on the Fast Edition button to
the right of the Tracker dropdown (it looks like a
magic wand). Skrooge will find the last operation
that matches the field you are currently in and fill in
the rest of the operation for you.
Scheduled Operations
Just as the title says, scheduled transactions (like
rent that you pay once a month or that life insurance

Linux Financial Apps: Skrooge

http://skrooge.org/
http://docs.kde.org/development/en/extragear-office/skrooge/index.html
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payment that comes out automatically every month)
are added and edited here. Choose the operation
you want to schedule (I chose the life insurance
payment) and click on Templates at the bottom of
your Operations screen, then open a tab with
Scheduled Operations, and edit the template you
just saved.
Trackers
A tracker allows you to group specific transactions
together in order to give yourself a total for those
expenses. Suppose you are going on vacation and
want a total amount spent on the trip. You can group
the transactions for fuel, lodging, recreation and food
in a tracker and you will have a total cost for your
vacation. This will work really well if the expenses
you track are some for which you will get
reimbursed. You can add the deposits to your
tracker as well, and thus will know when you have
been completely paid. I added a tracker named
Hawaii Trip in this window. When I enter data in the
Operations tab, I have a selection along with the
other items called Tracker. This dropdown now
contains the tracker called Hawaii Trip. As I add
expenses, I can go to the Tracker tab and see what
my total is.

Payees
As in the other programs, you add the payees as
you enter your transactions. Here you can add, edit
and delete them.
Categories
Skrooge includes an assortment of standard
categories, which can be edited. If you decide to
delete a category, any operation you have assigned
to that category will then have no category related to
it  so make sure you reassign those to other
categories.

Budget
The User Guide has nothing about the budget
section, so I have only experimented. As far as I can
tell, you have to add your categories oneatatime
and give the budgeted amount for it (and if anyone
uses Skrooge, please post on the forum if it is
different).
Search & Process
Search and Process is a way to find certain
operations and apply some sort of transformation.
What comes to my mind is when I was using a
different program and decided to change the
categories so they were more meaningful. I
remember having to search for every transaction in
one category and assign it to the new, better
category. With Search and Process, you could find
them all, and change them all at once.
Report
In Skrooge, every report has to be setup manually.
The standard items you must decide are the date
range to use, account(s) included and categories
and/or payees The Users Guide has some
examples to help set up some of the more standard
reports.
Monthly Report
The Monthly Report is an overview of a particular
month.
Units
In Skrooge, you can use more than one unit, not
only your standard unit of currency, but others if
needed. Units can also be stock shares, or even
autos or property.
Simulations
Simulations are not covered in the User Guide, but I
think it may be a prediction of your future finances,
based on the information you have already entered.
Configuring your Window
One of the things I like and also dislike about

Skrooge is that each section can be configured to
include only the information you want to see. In the
operations tab, I want to see the standard items I
might see in my checkbook: Date, Check Number,
Payee, Check Amount, Deposit Amount and
Balance. In Skrooge, there are many more choices,
as seen below. You simply have to rightclick one of
the columns and look at the drop down menu.

As you can see there are many items you can use in
your Operations list. You can have the check amount
and deposit amount in the same column (+/
Amount), or you can have them separate (
Expenditure and +Income). Simply click the
checkmark in front of each item on or off depending
on whether or not you want to include it. At the top
you can turn on or off the item “Auto Resize”.
Unchecking it will allow you to resize your columns
the way you want them, and checking it will set
specific column widths. When you have it the way
you want it, click on the save icon on the tab itself.
You can also go to View > Save Page State to do
the same thing. I like it because I can configure the
page the way I like, but I don’t like it because it
doesn’t always stay exactly the way I have

Linux Financial Apps: Skrooge
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configured and saved it (like sometimes the columns
jump to a smaller size than I chose).
I also don’t like the fact that each section has to be
configured separately. I know each has its own
information and should be configured on its own, but
I’m thinking there should be a better way to do it,
maybe from the Configure Skrooge window in the
Settings menu.
On the other hand, I like the zoom feature in the
window, which allows you to make the font whatever
size is easiest for you. Also, you can remove any of
the docks in the left column from the main window if
you wish, and let it sit by itself. I haven’t tried that
feature but it might be useful to some people.
Skrooge seems like a good program, and it has
features that are very good. I hope they get the User
Guide completed for the people that use it.
We have reviewed seven financial programs, and
hope you can find one that works perfectly for your
needs!

Screenshot ShowcaseScreenshot Showcase

PCLinuxOS Magazine Mailing List:
http://groups.google.com/group/pclinuxosmagazine

PCLinuxOS Magazine Web Site:
http://pclosmag.com/

PCLinuxOS Magazine Forums:
http://www.pclinuxos.com/forum/index.php?board=34.0

Reach Us On The Web

Posted by weirdwolf, August 20, 2012, running LXDE.

Linux Financial Apps: Skrooge

http://groups.google.com/group/pclinuxos-magazine
http://pclosmag.com
http://www.pclinuxos.com/forum/index.php?board=34.0
http://www.pclinuxos.com
http://ge.tt/93lE3L8?c
http://www.linfx.com
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window configuration, simply
uncheck SingleWindow Mode.
So, Gimp gives you the
choice. You can run it in one
single window or run it in it's
well known classic three
window mode. There are
many, many more changes in
this new version of Gimp and
we'll be exploring them in
future issues of PCLinuxOS
magazine, so please stay
tuned! And, since it's back to
school time once again, Gimp
is the perfect free computer
application for teachers and
students! And the best way to
get Gimp is to simply get
PCLinuxOS and install it! With
PCLinuxOS, students get an
entire operating system and all
the tools they'll ever need for
their studies, including Gimp,
LibreOffice, Scribus, and many
others!

Mark's Quick Gimp Tip

Mark Szorady is a nationally
syndicated cartoonist with
georgetoon.com. He blogs at
georgetoon.com/blog.
Email Mark at
georgetoon@gmail.com.

We've got a new version of
Gimp! It's version 2.8.0 and it
comes with a whole slew of
new improvements! The
biggest, and most anticipated,
is single window mode. With this new
feature, Gimp can now run in a one window
environment just like all the other well
known commercial graphics editors. To get
into single window mode, on the menu,
simply click on Windows and check
SingleWindow Mode. Once enabled,
Gimp will automatically configure itself into
one single window with toolbox on the left
and other dockable tabs on the right. When
you close and reopen Gimp, it will once
again open in one single window. Gimp will
stay in this single window mode until you
disable the feature. To go back to the multi

Answers on Page 38.

Mark's Quick Gimp Tip & Double Take

www.gimp.org
www.gimp.org
www.georgetoon.com
www.georgetoon.com/blog
mailto:georgetoon@gmail.com
www.gimp.org
http://www.pclinuxos.com/?page_id=180
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ms_meme
Grilled Potatoes

I like grilled vegetables. These are potato slices
coated with olive oil, garlic salt and a bit of hot
pepper. We are using a small electric grill. The
slices are nice and big so they don't fall through
the cracks. Since the grill is small, we do the
potatoes first. While the crispy taters go well
with the meal, they are usually gobbled up while
waiting for the chicken to finish grilling. Green
peppers, onions, tomatoes and zuchinni squash
are also favorites we put on the grill.

ms_meme

Tabouli
This is a Middle Eastern dish made with bulgar
wheat and chopped vegetables. I don't know the
recipe because I stay clear of the kitchen when it
is being made. Too much slicing and dicing for
me. I just clean up the kitchen after the mess is
made. While there are different varieties, ours is
made with chopped tomatoes, green pepper,
onions and parsley. It is marinated in olive oil
and vinegar, salt and pepper and oregano. It is
delicious and even better the next day if any is
left over. Our kids called it tapooli and tapooli it
remained.Here are some members recipes

And it's really not surprisin'
All of them look delicious
And deserve a Nobel Prizin'

It's Cookbook time again
Oh how we love to eat
And if somebody else is fixin'
It's even more of a treat

A recipe may well tell us
What it is you are advisin'
But a picture of the dish
Will make it more appetizin'

Forum Foibles: PCLinuxOS Summer Cookbook



PCLinuxOS Magazine Page 12

Rudge
Chicken Pot Pie

I have always been interested in cooking
because as a kid, my Mom used to "pretend" to
let me help. Most of my time was spent licking
spoons that had been used to make the frosting
on a cake. But I must have paid closer attention
to what she was doing than I thought. Some
basic, valid cooking techniques have been
embedded into my brain that I never learned
though a cooking class of any kind. I
instinctively knew for instance that tough cuts of
meat require a long slow cooking process and
that eggs should be a tad bit "liquid" when they
come out of the pan. I also seemed to know that
"Country Fried Steak" isn't done until it is "Over
Done" and that a basic biscuit gravy is the main
ingredient in a banana pudding.
I don't know how many people already know this
but, I have been divorced, twice. Previous
iterations of my life have left me with both, more
information about how to cook food and less of a
desire or need to do it.

One thing that always got me through the hard
times was a store bought, frozen chicken pot pie.
If you can find a good one, they are the bomb, or
so I thought. Now that I am happily married (for
11 years now) it has given me the time and
motivation to pursue my instinctive cooking
knowledge. My love for those chicken pot pies
that got me through those tough times inspired
me to learn how to make them from scratch.
Start with a basic rue of fat, butter and flour
Thicken that rue with a chicken broth
Add corn, peas, sautéed onions and mushrooms
Last, add previously cooked 1/2 inch squares of
white meat chicken
Pour that mixture into an oven safe dish
Cover the whole thing with a pie crust and give it
a thin egg wash
Bake at 450 F until the crust is golden brown
No more tough times but no more "Frozen"
chicken pot pies either!

ms_meme
Eggplant Lasagna

We prepare a lot of meatless meals. I have been
able to give up the beef but not the cheese. I do
use the low fat kind. Eggplant lasagna is a dish
we enjoy. The sauce is made with tomato sauce,
canned diced chili tomatoes, onions, parsley,
green pepper, oregano and garlic. The eggplant
is sliced thin and browned in olive oil. Layer the
lasagna noodles, mozzarella or cheddar cheese,
sauce and eggplant in a baking dish. Bake in the
over at 350 F for about 40 minutes. Sorry I did
not give exact ingredient amounts. We just keep
adding and stirring until it looks like enough.
If eggplant is not available, we substitute canned
spinach, cooked cauliflower or sauted cabbage
and carrots. We are never without vegetables at
our house. If the lasagna is served with red wine
and French bread you won't notice the
vegetables.

Forum Foibles: PCLinuxOS Summer Cookbook
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Jalapano Peanutbutter Sandwich

I'm like some of the recipe placers and like to
mess around in the kitchen. As you know I love
onions and garlic and hot sauce, but not the kind
that gives you blisters in your mouth. I like to
cook using beer. In fact I made tht beer can hot
sauce chicken a few times.

Usually when we go to my brotherinlaws
campsite on the 4th of July, I have a big seal a
meal bag of chicken to cook up. It has been
soaking in all sorts of spices, hot sauce solution
in the bag for better than a day. I spoon the
solution over the chicken while it is cooking on
the grill. Sure smells great when cooking and
tastes great also.

Here's a recipe that has has another hot flavor.
Cover a slice of jalapeno bread heavily with
butter. Cover another slice heavily with crunch
peanut butter. Smack those slices together and
let your mouth enjoy a great experience. If you
make one of these peanut butter sandwiches, try
it toasted with plenty of butter on the outside.
After one you will want more!

Good cooking!

Meemaw
Cucumber Salad

Slice 2 cucumbers & 1 onion.
Put in a bowl and cover with vinegar or 1/3 c
vinegar + 1/3 c water, depending on how sharp
you want it.

You can add 1 to 2 tablespoons of sugar. Salt
(1/2 t.) & pepper (1/8 t).

Mix well. Cover and let sit overnight in
refrigerator.

This makes a tangy side dish for summer when
everyone's gardens are full of cucumbers. It can
be garnished with chopped dill.

Forum Foibles: PCLinuxOS Summer Cookbook



List the file:
ls ~/example.txt
Tada!
/home/mylogin/example.txt

I hope you find this helpful.

by AndrzejL

Lets say that I have created a VERY important file.
Its a file called example.txt, and it’s placed in my
home (~) folder:
touch ~/example.txt
I want to copy this file to my remotemachine.net,
mylogin’s home folder, but I don’t want anyone to be
able to sniff the file’s content. The remote machine
has SSH server running. Scp is perfect for this task.
It uses encrypted ssh.
How to use it?
Syntax:
scp /path/to/secret/file.extwho@host:/where/to/save/
Example:
scp ~/example.txtmylogin@remotemachine.net:~
Result:
example.txt 100% 0 0.0KB/s 00:00
Check procedure:
Log into the remote machine:
ssh l mylogin remotemachine.net Support PCLinuxOS! Get Your OfficialPCLinuxOS

Merchandise Today!

Visit Us On IRC
• Launch your favorite IRC Chat Client software
(xchat, pidgin, kopete, etc.)

• Go to freenode.net

• Type "/join #pclosmag"
(without the quotes)

Copy Files Securely BetweenLocal Machine & Shell Account

http://www.cafepress.com/pclinuxos
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by Paul Arnote (parnote)

In our short series about KompoZer, the Gtk+ based
WYSIWYG HTML editor in the PCLinuxOS
repository, we’ve covered the basic layout of the
KompoZer application window, and how to use
KompoZer to create a rudimentary web page. This
month, we’ll learn about special formatting you can
do to your HTML page to add even more features.

Tables
Tables are ideal for presenting information in a very
organized manner, and keeping similar content
grouped together under a common heading.
For as long as I can remember, I’ve always dreaded
creating tables in HTML. They always seemed to be
unnecessarily complex – so much so, that one
mistyped command just sent it over the edge.
Fortunately, KompoZer makes the creation of tables
very simple.
Open the HTML file we created last month, and
position your text caret at the end of the text we
previously entered. Hit the Enter key a few times,
then select the “Table” icon on the KompoZer
toolbar.
Clicking on the “Table” icon on the KompoZer toolbar
causes the “Insert Table” dialog to be displayed.
Here, you can decide how many columns and rows
you will need in your table. Just as it is when you
start to lay out your web site, having a good plan in
place helps in helping to make a proper HTML table.

In the graphic above, the default value is a 2 x 2
table. That means that you have two columns and
two rows. The dialog box allows you to select a table
with up to a 6 x 6 table, or as small as a 1 x 1 table.
So you may be asking yourself, “why would I want a
1 x 1 table?” The easy answer is so that you can
have more control over how your text appears in the
web browser. In fact, I use 1 x 1 tables when I
produce the magazine’s web site. It enables me to
limit the width of the text I’m entering, without
resorting to inserting a “hard return” in the text. I do
this to help achieve a cleaner look, where the text
and data are all the same width. Using the 1 x 1
table as a formatting tool has worked to help achieve
the look that I was after.
You should now have something on your screen that
looks similar to that in the image below. Right click

your mouse in the representation of your table, then
select “Table Properties” from the context menu.

Click on the “Table” tab in the Table Properties dialog
box, and your dialog box should look similar to the

KompoZer, Part 3: Special Formatting
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one shown above. We have to alter a few settings.
First, under the “Size” settings, set the width of your
table to how many pixels you want your table to be.
The default value is “% of window.” Just click on that
dropdown listbox and change it to “pixels.” Then
enter the number of pixels for the width of your table.
In the example above, I have set that value to 300
pixels.
Next, under “Borders and Spacing,” you can
optionally change the “Border” setting to zero (0)
pixels. This will make your table invisible to your
website visitors, yet allow you to use the table to
help your format the text on your website. Feel free
to “play around” with the “Spacing” and “Padding”
setting values until you achieve the look and feel
that you are after.

Now, click on the “Cells” tab.
Under the “Cells” tab, you can change the height
and width of individual cells, as well as the vertical
and horizontal alignment of items that appear within
the cell. One thing that you will most likely want to
enable is “Text Wrap.” Place a checkmark in the box
next to “Text Wrap,” and insure that “Wrap” is
selected from the dropdown listbox. Click on the

“Apply” button to apply your settings, and then the
“OK” button to dismiss the dialog box.
Now, all that’s left is to enter the text you want to
appear in the table. Since I’ve created a 1 x 1 table,
that allows me to essentially use a table as a
text/content formatting tool. You can place whatever
you want within the table, and any/all content within
a table is subject to the formatting set up in the Table
Properties dialog box.
It may take you a time or two to get the hang of
using tables, but once you do, I think you will soon
see the worth of using tables to help you format the
content of your web page.

Anchor Links
Sometimes you want to give your website visitors
quick access to a particular section of your web
page. The use of “anchor links” makes this easy.

On my website for
respiratory care practition
ers, I have a “menu” of
sorts, listing all of the
sections of my web page.
In part, this is what it looks
like in Firefox (left).
Each one of those links in
the “menu” link directly to
that specific part of my
web page. That makes my
web page “menu” act very
similar to a table of
contents. Quite simply,
anchors allow you to link
to different areas of a web
page.
Within KompoZer, an
“anchor” appears just as

that – it has an image of an anchor in front of the
text. Here’s one such example, taken from my
respiratory web page loaded into KompoZer:

Notice the “anchor” symbol right in front of
“Government Sponsored Sites.” That indicates that
the text that follows (or part of the text) is an anchor.
That text can be linked to, either from within the
same HTML document, or via an external web link.
For example, to link directly with the “Publications”
section of my respiratory care web page, the
address would look like
http://home.comcast.net/~parnote/#Publications.
The last part of the URL – the part that contains the
“#” and the text after it – links up directly with that
specific portion of my web page. Go ahead and try it.
Just click on the link and you’ll see how it works.
Creating an anchor is very easy in KompoZer.
Simply highlight the text you want to use as an
anchor point, then click on the “Anchor” icon on the
KompoZer toolbar.
Typically, you’ll find the “Anchor Name” field already
filled in with the text that you highlighted. If you’d
prefer, you can give it another name. However, I
tend to just accept what already appears in the

KompoZer, Part 3: Special Formatting
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“Anchor Name” field. It helps to keep things simple.
If no text appears, just give it a name that closely
resembles the text you highlighted. It makes it much
easier to find the proper anchor when you go to link
to it.

Now that you have the anchor defined, you can
create an anchor link. When you create a link, select

the anchor you defined from the dropdown list.
That’s pretty much all there is to it.

KompoZer, Part 3: Special Formatting
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Publication
One of the nice features about KompoZer is that you
can not only create your entire website using the
WYSIWYG editing environment, but you can also
publish your website – or just the changes to
individual files – to your web host, right from inside
KompoZer when you are finished.
Before you can publish your website to your web
host, you will first need to set up the necessary
information for KompoZer to use to connect to and
negotiate file transfers between your computer and
your web host.
First, go to “Edit > Publish Site Settings...” and you
will see a dialog box similar to the first image on the
right on the previous page. Under the “General
Settings” tab, fill in all of the information that you
can. Then, click on the “FTP Settings” tab.
Fill in all of the settings you can in this tab, as well,
much as I’ve done in the second image on the right
side of the previous page. You will need to check the
“Save Password” box if you want KompoZer to
remember your password.
Under “Connection Type,” be sure to check with your
web host provider whether or not their server
settings allow you to use “Passive Mode.” If so,
place a checkmark in the box. If you are using IPv6,
place a checkmark in that box. FTP is typically an
insecure file transfer protocol, and you’re usually fine
with not messing with the “Security” settings. Since
“Port 21” is the typical port to use for FTP transfers,
you should be fine with leaving the port number
assigned to 21, unless your web host provider
specifies otherwise.
Once you’re ready to publish your website content,
click on “Publish” on the KompoZer toolbar. The
entire directory contents of your web site will be
uploaded to your web host. Alternatively, if you’re
updating only a few files, right click on the files as
they appear in the left hand pane of your KompoZer

window, and select “Publish” from the context menu
for each file you want to update.

Summary
As you have seen, KompoZer is a very good and
useful tool to use to create your web pages. Since
KompoZer uses an older version of the Gecko
engine (as we discussed in the first article), there are
a few slight differences in how the current Gecko
engine displays things. But that difference is not
represent a huge or insurmountable issue.
Generally, I’ve found KompoZer more than up to the
task for creating and maintaining a website.
There’s a lot more to learn about HTML, along with
web page and website creation. There are entire
sites and books devoted to the topic. This short
article series is not meant to be a complete or full
tutorial over HTML. Rather, its intent is to showcase
some of the capabilities of KompoZer, which is a
very useful tool to help facilitate the construction of
web pages and websites.

If you want to learn more about HTML, I would
recommend that you start with the tutorials at
w3c.org, since they are the body that sets the
standards for HTML. You can then use the
information you gain there to branch out to other,
deeper discussions and tutorials about HTML.

KompoZer, Part 3: Special Formatting
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Screenshot ShowcaseScreenshot Showcase
LinPC.us

Available in the following desktops:
KDE LXDE Xfce

Gnome Enlightenment e17
Posted by MGBguy, August 26, 2012, running KDE4.

http://www.linpc.us
http://www.pclinuxos.com
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by Meemaw

So far we’ve learned a little about the layout of the
Gimp, and used some of the tools to draw a face
and a bow. Let’s experiment a little more.

You may wonder what is going on with the Bow layer
because we can see the edge of it on our drawing.
That is because that layer is selected at the
moment. When you choose or create another layer,
that line won’t show.
Let’s create another layer named “Text” (you can
rename it or leave it as “New Layer”). Make it
transparent as well, so we can see our drawing
through it. Click on the Text tool, and you will see
another window pop up. It is the text editor window
and, working together with the toolbox window, it
contains anything you might want to use to edit text
in your image. In the text editor box, you should type
the text you want. I typed, “I Love GIMP” in the box.
Notice that I spaced it the way I want it as well (with
each word on its own line). In the tool box are the

text formatting tools (font, size, color, alignment, etc)
so you can make it look however you want.

I chose the font called Die Nasty, size 44, black,
centered. If you check the box “Use selected font” in
the text editor box, you’ll be able to see what it looks
like in the editor. This is good if you want to try
different fonts.

Notice in your layers window that your text is not on
the layer you created, but rather it is “Floating”
above it. Until you are finished editing your text, it
will remain as a Floating layer.

Let’s do something different to our text. Rightclick
on the floating layer in your layer window and
choose Alpha to Selection. You will now see that
your letters of text are outlined with dotted lines.
Click on the gradient tool in the toolbox and pick one
of the gradients there. (I picked dark blue to light
blue.) Click on one side of your text and drag to the
other side. The gradient you picked should be inside
the text outlines now. If you click in the top left
corner and go to bottom right, your gradient will be
diagonal. If you don’t like it you can press <CTRL> +
<Z> to undo it and try something else. After I chose
the blue, I changed it to a tropical gradient.

Graphics Tutorials: GIMP, Part 3
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When you have it colored the way you want it, go to
Select > None in the menu. This will change your
floating text to an image file, which can be moved to
any place you want in your drawing.

All this time, you have been saving your creation as
a Gimp native .xcf file. This is good, because it
preserves the layers for you so you can make
changes to any of them. So what do you do if you
have your drawing finished and you want to post it
on the Internet as a .jpg or a .png file? With the new
version of Gimp, the File menu is a little different.
Save... means save
your drawing as an
.xcf file. Save As...
means save it as an
.xcf file (still) but with
a different file name. If
you want to save it as
a .png file (or any of
the other recognized
file formats), you will
have to Export your
drawing. It is easy,
though: go to File >
Export... and edit the
entries that are there
>>>>

The folder location can be changed, but will probably
be the same folder that your .xcf file is in. The
program will assign the same name to this file as the
name of the .xcf file you’ve been editing, but that can
be changed as well. In the dropdown at the right
side of the window, you will see all the file formats
you can use. I use .png and .jpg most of the time,
but use what you want. You will probably get at least
one window with options. I generally use the defaults
that are there. You will now have your basic file to
edit however you want, and also an image file you
can insert into another document, use as wallpaper,
or print.

The new version of Gimp has
the single window display. You
simply Click on Windows >
Single Window Mode. When it
is checked, your windows are
fused together. When you
uncheck it, the sections are
separate. You should choose
whatever mode you are most
comfortable with.
Next time we’ll explore more
tools.

It's easier than E=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...

Graphics Tutorials: GIMP, Part 3

http://www.pclinuxos.com


PCLinuxOS Magazine Page 22

by Patrick G Horneker (phorneker)

Television has been a primary source of
entertainment for as long as we can remember. The
way we watch television these days has changed,
from the transition to all digital broadcasts back in
2009, to streaming video on the Internet, to Internet
enabled television sets (of which most of them
embed Linux in one form or another).
PCLinuxOS provides a number of applications that
allow us to watch online video. However, there are
some video services and media types that are not
compatible with a stock PCLinuxOS installation.
Hence, to be able to watch online video, we need to
install some packages from Synaptic.

Preparing your PCLinuxOS installation for video
streaming
The first thing we need to do is to launch Synaptic.
Be sure to update PCLinuxOS itself first using the
Reload, Mark All Upgrades, and Apply method.
Once PCLinuxOS has been updated, click on
Sections, select Tasks, then select taskmultimedia.
This package brings in the basic components
needed to view common multimedia types (and play
your favorite DVDs as well). Click on Apply to install
what you need.
Next, we should install the following packages for
support for the most multimedia types:
gstreamer0.10speex
gstreamer0.10mpeg
gstreamer0.10x264
gstreamer0.10vdpau

gstreamer0.10dirac
gstreamer0.10twolame
gstreamer0.10cdparanoia
gstreamer0.10aalib
gstreamer0.10jack
gstreamer0.10pluginsugly
gstreamer0.10cog
gstreamer0.10pluginsbase
gstreamer0.10amrwb
phonongstreamer
gstreamer0.10pluginsbad
gstreamer0.10faac
gstreamer0.10gnomevfs
gstreamer0.10caca
gstreamer0.10amrwbdec
gstreamer0.10directfb
gstreamer0.10soup
gstreamer0.10soundtouch
bluezgstreamer
gstreamer0.10mpeg2enc
gstreamer0.10faad
gstreamer0.10celt
gstreamer0.10cdio
libgstreamer0.10_0.10
gstreamer0.10dv
gstreamer0.10pulse
gstreamer0.10resindvd
gstreamer0.10vp8
gstreamer0.10ladspa
gstreamer0.10jp2k
gstreamer0.10vaapi
gstreamer0.10a52dec
gstreamer0.10ffmpeg
gstreamer0.10pluginsgood
gstreamer0.10python
gstreamer0.10libvisual
gstreamer0.10lame
gstreamer0.10kate
gstreamer0.10amrnb

gstreamer0.10gsm
libgstreamerpluginsbase0.10
gstreamer0.10xvid
gstreamer0.10dts
gstreamer0.10flac
libquicktime0
libquicktime
libquicktimeprogs
openquicktime
libquicktimelame
openquicktimeapps
libquicktimedv
libquicktimex264
libquicktimefaad
libquicktimefaac

Be Sure PulseAudio Is Activated
Next thing we should do is to be sure PulseAudio
has been installed and activated. PulseAudio allows
more than one application or process to use the
audio card or audio input devices at the same time.
This is useful when running audio applications under
the KDE or GNOME desktops, of which both
environments have processes running that use your
system’s audio card.
The easiest way to get PulseAudio on your system
is to launch Synaptic and install the task
pulseaudio package. This installs PulseAudio and
all packages it depends on to function. I recommend
installing paman and pulseaudioesoundcompat
as well for added functionality.
Once installed, run PCLinuxOS Control Center (also
called Configure Your Computer), supplying the root
(administrator) password when requested (next
page).

Watching Online Television on PCLinuxOS
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Select Hardware from the sidebar, then click on
Sound Configuration.

Next, click on Enable PulseAudio to activate
PulseAudio. If you are connecting your PCLinuxOS
machine to a home theater, or a 5.1 channel audio
system, click on Enable 5.1 sound with PulseAudio.
Otherwise, leave everything else as it is. Click on
OK. You will get a message asking you to reboot to
enable PulseAudio. Click on OK again to clear this
message. Close PCLinuxOS Control Center, then

reboot PCLinuxOS to enable PulseAudio, as
PulseAudio system is a process that replaces ALSA
for the audio subsystem.
PulseAudio works with any application that works
with OSS (Open Sound System) and ALSA
(Advanced Linux Sound Architecture). The reason I
recommended the pulseaudioesoundcompat
package is that this package allows PulseAudio to
accommodate applications that use ESound
(Enlightenment Sound daemon, the audio process
daemon designed for the Enlightenment window
manager).
Once rebooted, you will no longer have access to
audio mixers that work with ALSA or OSS, but then
you will not need them. PulseAudio has its own
mixer applications that work with KDE or GNOME,
as well as other window managers.
We now have PCLinuxOS ready to handle online
video and audio without interference from the
GNOME or KDE daemons that take over audio
functionality.

Watch OnLine Television With a Web Browser
Applications such as Firefox, Opera, and Chromium
allow you to view online videos from websites that
provide such services. This is the easiest way to
watch online videos as all you need is a web
browser and appropriate browser plugins.
Youtube is the definitive source for online video of
any kind. The people who maintain the fan site of
Jim Carrey, http://www.jimcarreyonline.com,
uploaded all thirteen episodes of Duck Factory to
Youtube. Duck Factory was a sitcom produced in
1984 starring Jim Carrey about a Hollywood studio
that produced a cartoon called Dippy Duck. Type
duck factory jim carrey into the Youtube search to
view these episodes.
Enough said here.

Hulu is a source for television shows and movies.
The free service allows you to access television
shows and movies (not the newest or the most
popular) with a web browser and their embedded
viewer. Hulu Plus is a paid service that allows you to
view the newest television programming and videos,
not only with a web browser, but with smartphones,
tablets, television streaming devices and Internet
enabled television sets.
Owned in part by NBC Universal (Comcast/General
Electric), News Corporation, and Disney, Hulu
provides some great classic television, including
Saturday Night Live (every episode ever produced),
Mary Tyler Moore, Bob Newhart (both the original
series and Newhart), The Dick Van Dyke Show,
McHale’s Navy, Green Acres, Night Gallery, and
older classics such as Flash Gordon (from 1936)
and Lone Ranger.
This service is paid for with advertising, and you do
not have to login to view content. You may signup for
an account for personalized recommendations.
Many media companies provide video on demand
services (in addition to separate accounts at
Youtube).
Russia Today offers videos you can not only watch,
but freely use! http://freevideo.rt.com
Canadian Broadcasting Corporation has an archive
you can browse for television and radio clips.
Streaming video cannot be viewed from the US due
to Canadian copyright restrictions. However, you can
stream radio broadcasts from the CBC.
Media Center Suites
There are several products installable from Synaptic
that transform your PCLinuxOS installation into a
media center. These suites are full screen
applications designed for playback of media from
configurable sources, including local files on your
machine.

Watching Online Television on PCLinuxOS
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Moovida is a HewlettPackard sponsored suite
written entirely in Python. Currently, only Youtube is
configured for streaming video.

This is what you see when you launch Moovida.
Clearly, this interface works best on tablets and
smartphones, yet Moovida was implemented for
desktops, laptops and netbooks. Navigation here is
best done with your computer’s keyboard (using the
arrow keys, the escape key and the return key), or
the scroll wheel on your mouse.

Moovida comes with a sparse collection of plugins,
two of which need to be updated just after launching
Moovida for the first time as we can see above. For
streaming video, Youtube is currently the only
service available from Moovida. Here, you can

search Youtube, or browse a list of top rated videos,
most popular, most viewed, or recently uploaded
videos.

When you launch Moovida for the first time, Moovida
will recursively scan the Pictures, Videos, Music,
and Movies directories in your home directory for
usable media files.

XBMC
This media center suite can run within a window
manager, a desktop environment such as KDE,
XFCE or GNOME, or it can take the place of a
window manager. When installed from Synaptic,
XBMC appears as a selection in the session menu,
the same as KDE, GNOME or WindowMaker, from
the login screen, either kdm or gdm.
XBMC stands for XBOX Media Center, and as the
name implies, was designed to create a media
center using the original XBox gaming console.
When you launch XBMC for the first time, the
following appears (top right):
You can use a mouse to navigate the menu system
(which is in the center of the screen). Notice that
submenus appear while highlighting the current
selection.

Sources for video and audio are configurable
through downloadable applications designed for
XBMC. Applications can be activated by selecting
Programs from the main menu.
As shown here, the first thing we need to do is to
change a few settings. The current temperature for
my location has not been set.
The System menu is where we configure XBMC
options.

Here, we want to select Settings to start configuring
XBMC (next page).

Watching Online Television on PCLinuxOS
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Here, we can select Appearance, where we can
change themes (called skins). Skins are packages
that are written in XML, and embed graphics in the
same directory (not unlike themes in WindowMaker).
The xbmctex package available in Synaptic allows
you to compile your own skin packages for use with
XBMC.
On the main screen, there is a current temperature
displayed at the top, not unlike the GNOME Weather
applet. Weather allows you to retrieve the current
temperature for your city using the Weather
Underground service (recently acquired by the
Weather Channel).
AddOns is the applications manager for XBMC. It is
here where we can add sources for viewing
television shows and movies, as well as
photography archive services such as Flickr and
Picasa, and streaming radio and customized music
services.

Video Sources Available to XBMC
Configuring sources for online video in XBMC is only
two clicks away. From the main screen, select
Videos, then select AddOns (center, top).

As we can see, XBMC offers 139 sources for video,
including Youtube. As you scroll through the list, you
will see descriptions to the right of what each
application (called AddOn) provides to XBMC.

Note: Not all addons are functional. Avoid installing
addons that are marked broken.
At top right, I have one of my favorite networks
highlighted (Food Network). To install any addon,
simply double click on the menu item.
...and here is the Youtube addon that allows XBMC
to access Youtube videos. Also note that
WatchItLater and Ziggo TV Streams are not
functional addons (center, right).

Here, we are ready to install the Youtube addon.
Click on Install and it instantly becomes available for
use.

Watching Online Television on PCLinuxOS
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Click on the Home icon, at the upper left hand
corner of your screen, then click on Videos.

Here, we are now able to view videos on Youtube.
Click on Youtube and we get the following:

If you have a Google account, you can login to
Youtube by filling in the Username and Password
fields.
Click on OK to exit this screen.

This is what you see when you click on Youtube
after the initial setup. Let us click on Explore
Youtube. There are numerous categories to explore.
For the next example, we shall select Classic TV.
(This article is called Watching OnLine Television,
after all.)

We can see that whatever is classified as Classic TV
on Youtube shows up here.
OK, so The Brady Bunch is not a great example

here. But then, public television’s Sesame Street is
classified as a Comedy on Youtube.
Within the results here are the number of clips that
you can watch.

Boxee
The Boxee client, installable from Synaptic, is a
reworking of XBMC for use with the Boxee service
(including the branding). This, of course, means you
must create a user account at Boxee, which could
then be used with applications for your smartphone
or tablet, or on Boxee’s router for television sets.
Signing up for Boxee is free, and can be done either
with a web browser, or through the Boxee client.
Like XBMC, video, audio and photographic services
are configurable through applications downloadable
from within the Boxee client.

This is what you see when you launch Boxee. Here,
we can login to boxee.tv using this client. If this is
the first time you launch Boxee, the following will
appear. Display settings will automatically be
detected, so you can just click on Next to get to the
main screen.

Watching Online Television on PCLinuxOS
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The newsfeed on the left is enabled if you have a
Twitter account, and that account is enabled from
the boxee.tv website.
Click on TV Shows to access a library of television
programs. Boxee displays 200 of their most popular
television series. The Apps item allows you to
access more services, including Youtube, where you
can watch online video.

Banshee Media Player
Banshee allows for viewing of online and local video
files. The default Banshee configuration allows for
viewing of videos from the Internet Archive
(http://www.archive.org) and from the Miro Guide
(http://www.miroguide.com).

The following screenshots show Banshee displaying
the Miro Guide and Internet Archive pages.

Miro Standalone
Player
This application
provides a bit
more functionality
than the Miro
plugin for
Banshee.

When Miro Internet TV is launched for the first time,
you will be asked some questions in order for Miro to
be setup. The first of these questions asks for the
language the application is to be displayed.
Obviously, we want to click Next here to use the
English language (or whatever language is set for
your PCLinuxOS installation).

As Miro uses large quantities of system resources,
the default is for Miro not to start when KDE is
launched. I recommend clicking on Next to this
question.

You can choose to select a directory where your
video or audio files are stored. Once Miro is
launched, you can add directories for Miro to search
later. Click on Finish to setup Miro.

Watching Online Television on PCLinuxOS
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This message appears because there is no
subdirectory called Miro in your Videos directory.
This directory is not created by default. You can click
on Continue and Miro will use the Videos directory
within your home directory instead.
Alternately, you can click on Quit, then create the
directory using a file manager or a terminal window
(type mkdir ~/Videos/Miro to create the
directory). Then relaunch Miro.

As we can see, there are five sources preconfigured
for watching online video, namely Youtube, Hulu,
PBS Online, Youtorrent, and Clearbits. Additional
sources can be manually configured as shown at
center top:
One could say that Miro is a cross between a media
player and a web browser (right).

Of course, we can playback podcasts on Miro, with
five sources here preconfigured: TED Talk,
Lifehacker, This American Life (from National
Public Radio), The Moth Podcast, and VODO
Promoted Works.
Note: Most of the content provided with Lifehacker is
targeted for Windows and Mac OSX users, and may
or may not be relevant to PCLinuxOS. This of course
can be changed as we use and select podcasts for
viewing.
This article is about viewing online television
programs, movies and video using software
available on PCLinuxOS without additional hardware
such as television cards or adapters, webcams, or
video capture devices.

International CommunityPCLinuxOS Sites

Netherlands

Turkey

Denmark
Czechoslovakia

Italy

Poland

Brazil

Watching Online Television on PCLinuxOS
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http://pclinuxos.fi/
http://www.pclinuxosbrasil.com.br/
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by Paul Arnote (parnote)

We’re all familiar with Synaptic. You know, that front
end GUI to aptget that we all use to keep our
PCLinuxOS installation uptodate. You are updating
regularly, right?
But let’s say you have just bought a new solid state
drive (SSD), and you need to reinstall PCLinuxOS
after you install the SSD. Or, maybe you bought a
new laptop and you want to duplicate the installed
applications from your desktop computer onto the
new laptop. Or, maybe you just need to do a fresh
installation – for whatever reason – but you don’t
want to spend hours opening and closing Synaptic
to install all of your favorite applications.
I’ve been there, with that latter scenario. Just as
soon as I close Synaptic, I remember one or two
more applications that I frequently use, but forgot to
install. So I open Synaptic again, install those
applications (plus a few more that get jogged in my
memory, usually), install those, then close out of
Synaptic. A few minutes later, I remember a couple
more applications. Then the cycle repeats – several
times, unfortunately.
Luckily, there is a better way to help insure that all of
your favorite applications are installed, the first time.
Synaptic provides you with this tool, but does so in
such a way that you may not even know it’s even
there and available. Here’s what you need to do.
First, open Synaptic and make sure you are fully
updated before proceeding any further. You know –
Reload, Mark All Updates, Apply, etc., etc.
Then, select “File > Save Markings As...” to display
the “Save As” dialog box. Since Synaptic is running

as root, you will have to select where to save it. I
would suggest saving your markings to a USB
flash/thumb drive, especially if you are moving that
list to a different computer.
Do you notice the extra little checkbox in the lower
left corner? The one that says “Save full state, not
only changes”? The “secret” to this working is that
you have to check this checkbox. Then, give your
“markings” file a name at the top of the Save As
dialog box. I use something simple and descriptive,
such as “SynapticMarkingsMMDDYY.txt.”
Next, click on the “Save” button to save your
Synaptic markings to your USB flash/thumb drive.
Once you’ve done that, getting the markings onto
the other computer (or the same computer, if you’re

Use Synaptic To Clone InstalledSoftware On Another Computer
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reinstalling) is very easy. Go to “File > Read
Markings” in Synaptic, and select the file you saved
them to in the previous steps. Then click on “Apply.”
Now, go have some pizza and a soda, or go fix
yourself a BLT sandwich (we all know how much
PCLinuxOS users LOVE bacon) while Synaptic
downloads and installs the files in your markings list.
Duplicate files will be skipped. When it’s all done and
over, your belly will be full and all of your favorite
applications that were previously installed will be
present and available on your new installation.

Are viruses,
adware, malware &
spyware slowing
you down?
Get your PC back
to good health
TODAY!
Get

Does your computer run slow?
Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

Visit.
Contribute.

Build.
The PCLinuxOS
Knowledge Base

It Belongs To YOU!

Screenshot ShowcaseScreenshot Showcase

Posted by RobNJ, August 11, 2012, running e17.

Use Synaptic To Clone Installed Software On Another Computer
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by D. Moore (YouCanToo)

This howto focuses on how to setup vsftpd server
on your PCLinuxOS based computer. The vsftpd
stands for “Very Secure FTP Daemon”. It is not just
secure as the name suggests but also delivers
excellent performance by consuming less memory.
The tutorial also teaches you how to configure by
adding FTP users and locking the directory to
individual users.

Installing vsftpd on PCLinuxOS
Open the Synaptic Package Manager and do a
search for vsftpd.
Now Mark the package for installation and click
apply.
WARNING: if you have any other ftp server installed,
it will be removed when you install vsftpd.
Click apply again. VSFTPD will now be installed onto
your system. Click "close" and then you can exit
Synaptic.

How to configure vsftpd
Before we get started we need to make sure the
vsftpd daemon is stopped. You can do this in a
console window as root. You should see something
like this:
[root@laptop dwmoar]# service vsftpd stopShutting down vsftpd:[FAILED][root@laptop dwmoar]#

Now we need to edit the
vsftp.conf file. In yourfavorite
text editor as the root user,
open the/etc/vsftpd/vsftpd.conf
file.
We need to change the
following options:
1. We don't want any
anonymous logins:
Uncomment the following and
change to the following

anonymous_enable=NO
2. Enable local users:
Uncomment the following and
change to the following

local_enable=YES
3. The ftpuser should be able
to write data:
Uncomment the following and
change to the following

write_enable=YES
4. Set umask to 022 to make
sure all files and folders have
proper permissions. (files (644)
folders (755))
Uncomment the following and
change to the following

local_umask=022

Installing & Configuring VSFTPD
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5. Turn off port 20, This makes vsftpd run less
privileged:
Uncomment the following and change to the
following

connect_from_port_20=NO
6. Chroot everyone: Make sure no one can snoop in
anyone else’s directory.
Uncomment the following and change to the
following

chroot_local_user=YES
 Our basic configuration is now complete. 
Let's now start the vsftpd service
In a console window as the root user, type in the
following
service vsftpd start
You should see something like this:
[root@laptop etc]# service vsftpd startStarting vsftpd for vsftpd:[ OK ][root@laptop etc]#
If you see the word "FAILED" this means there was
a mistake in the configuration file. Go back, double
check your work and try again.
Congratulations if you got the "OK". Your ftp server
is up and running.
Now let’s add a new ftpuser.
Since vsftpd has no gui we will need to do the
following from a console window as root.
adduser d/path/to/the/ftpusers/home/directory s/usr/bin/bash ftpuser*

where ftpuser* is the ftpuser’s name.

 EXAMPLE 
[root@laptop etc]# useradd d/home/mastermind s /usr/bin/bashmastermind
[root@laptop etc]#
Setup a password for the ftpuser
passwd ftpuser*
where ftpuser* is the name of the user.

 EXAMPLE 
[root@laptop etc]# passwd mastermindChanging password for user mastermind.New password:Retype new password:passwd: all authentication tokens updatedsuccessfully.[root@laptop etc]#
NOTE: the password is not echoed to the screen so
make sure it is entered the same both times.
In order to enable the ftpuser to read and write the
data in the home directory, change the permission
and take ownership:
chown R ftpuser/path/to/the/ftpusers/home/directorychmod 755/path/to/the/ftpusers/home/directory

 EXAMPLE 
[root@laptop etc]# chown R mastermind/home/mastermind[root@laptop etc]# chmod 755/home/mastermind

Create a userlist file and add the user.
nano /etc/vsftpd/vsftpd.userlist
and add the user
ftpuser*
where ftpuser* is the actual username
on a new line add the following
userlist_file=/etc/vsftpd.userlist
Now save your file.

 EXAMPLE 

One last change. Now create a usergroup and add
the ftpuser to it:
usermod G ftpuser ftpuser*
where ftpuser* is the actual username.

 EXAMPLE 
[root@laptop vsftpd]# usermod G mastermindmastermind

Installing & Configuring VSFTPD On PCLinuxOS
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Now restart the vsftpd service
service vsftpd restart
You should see something like this
[root@laptop vsftpd]# service vsftpdrestartShutting down vsftpd:[ OK ]Starting vsftpd for vsftpd:[ OK ][root@laptop vsftpd]#
If you see "FAILED" go back and recheck your work.
That’s it. Now you have a secure installation of
vsftpd on your machine.

Looking for an old article?Can't find what you want? Try the

PCLinuxOS Magazine'ssearchable index!

The PCLinuxOS Magazine
Created with Scribus 1.4.1

Screenshot ShowcaseScreenshot Showcase

Posted by gseaman, August 3, 2012, running KDE4.
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by AndrzejL

Wireshark is a network packet sniffer. When opening
it as a regular user, I had no capturing interfaces to
use as a source for sniffing. I don’t feel comfortable
running Wireshark as root. Nothing should be run
with root privileges unless there is absolutely no
other option. So I have decided to mess around with
Wireshark and to enable the packet capturing for a
nonroot user. After a bit of search online I was able
to do so.
Here is how.
I assume that you have PCLinuxOS installed / fully
upgraded and that you have installed Wireshark.
Run those commands to allow nonroot user the
Wireshark access:
su
give it a root password
aptget yes install libpcap libcaputils
give it some time to finish.
groupadd wireshark
usermod a G wireshark andrzejl
you need to change andrzejl to your log in
cgrp wireshark /usr/bin/dumpcapchmod 750 /usr/bin/dumpcapchmod o+x /usr/bin/dumpcapsetcap cap_net_raw,cap_net_admin=eip/usr/sbin/dumpcapgetcap /usr/bin/dumpcap

after that you can run:
exit
wireshark

This will start Wireshark from your user account. You
should now have access to the capturing interfaces.
Hope this helps somebody someday.

Running Wireshark as a Regular User
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I was surfing with my darlin' on that old Windows System
When an old friend just happened by
Introduced her to my darlin' and while they were surfing
She said, “Why not Linux you try?”
I remember the night as they surfed without stress
And I know they will always be blessed
Yes I lost my little darling the night we were surfing
Now he'll only use PCLOS

Well I surfed by myself on that old Windows System
Alone and forlorn I did cry
Then I went to the Forum where they were surfing
And they said, “Why not Linux you try?”
I remember that night and I must confess
To Windows I'll never regress
And I found a new darlin’when on Linux a surfing
And we only use PCLOS

ms_meme's Nook: PCLOS Waltz

MP3 OGG

http://pclosmag.com/html/Issues/201209/files/pcloswatlz.mp3
http://pclosmag.com/html/Issues/201209/files/pcloswatlz.ogg
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by AndrzejL

I have seen this question on multiple occasions: “My PCLinuxOS works just the
way I wanted it to and I want to back it up. How do I create ISO from it?” Today, I
have decided to show you how I do it.
First step: Check that you have drakxfinishinstall installed. Issue this
command:
rpm qa | grep drakxfinishinstall
If the output looks something like this (lines separated for clarity):
[andrzejl@wishmasbell ~]$ rpm qa | grep drakxfinishinstall
drakxfinishinstall12.802pclos2011
[andrzejl@wishmasbell ~]$
you are good to go. If not, issue this command:
su c "aptget update && aptget yes install drakxfinishinstall"
Give it the root password when asked, and some time to finish. Then, run
rpm qa | grep drakxfinishinstall
again. This time system should indicate that the package is installed.

Second step: Check for free space. Issue this command:
df
The output will look something like this. Of course you can have less (or more)
partitions mounted in different mount points, but you will have at least one /
partition.

[andrzejl@wishmasbell ~]$ dfFilesystem Size Used Avail Use% Mounted on/dev/sda1 25G 19G 5.1G 79% //dev/sda6 9.9G 8.8G 1.1G 89% /home/dev/sda7 37G 35G 895M 98% /media/Disk_1/dev/sda8 37G 33G 2.4G 94% /media/Disk_2/dev/sda9 20G 9.9G 8.9G 53% /media/Disk_3/dev/sdb1 74G 26G 44G 37% /media/Disk_4[andrzejl@wishmasbell ~]$
Now you can see which disk has enough space in it to create the ISO. In my
case, it’s the /media/Disk_4 because it has 44 GB of space available.
So, let’s say I want to remaster to this partition, and place it in the folder called
Remaster. And that I want to have all my data included.
Third step: Prep the folder and the remaster command. Run this command:
su
Give root password and then run this command:
mkdir /media/Disk_4/Remaster
This will create a folder where we will find out iso later. Don’t close this terminal
window.
Now for the remastering command (all on one line):
mylivecd xz nodir ^/media/Disk_4/Remaster/ tmp=/media/Disk_4/Remaster/ md5sum ufs unionfs/media/Disk_4/Remaster/my.iso
– mylivecd – script that will remaster the PCLinuxOS to the ISO file.
– xz – this will specify the compression method (there are other as well. Read
mylivecd –help if you want to know more).
– nodir – the folders listed will not be added to the ISO.
– tmp – this will be our temporary folder for the mylivecd process.

Remaster YOUR PCLinuxOS Installation
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– md5sum – this will embed md5sum in the ISO.
– ufs – this will specify the union file system.
– /media/Disk_4/Remaster/my.iso – this specifies where the ISO will be written.
So, in general, the command should look something like this (lines separated for
clarity):
su
mkdir /whatever1/whatever2
mylivecd xz nodir ^/whatever1/whatever2/ tmp=/whatever1/whatever2/ md5sum ufs unionfs/whatever1/whatever2/whatever.iso

If your installation is not massive and bloated, after running this command it
should create a remaster iso. However, sometimes you will receive error like this
one:
mylivecd, version 0.9.4, http://pclinuxos.com/Copyright (C) 2010, Texstar
This program is free software; you can redistribute itand/ormodify it under the terms of the GNU General Public Licenseas published by the Free Software Foundation; eitherversion 2of the License, or (at your option) any later version.Disabling Services not needed on the LiveCDrunning: /sbin/chkconfig –listrunning: /sbin/chkconfig –listrunning: /sbin/chkconfig –listrunning: /sbin/chkconfig –listrunning: /sbin/chkconfig –listCreating initrd: [100.00% 00:00:07/00:00:07]Setting filesystem parameters: [100.00% 00:00:04/00:00:04]Creating compressed image: [100.00% 00:14:10/00:14:10]Creating isolinux boot: [100.00% 00:00:01/00:00:01]Creating final iso: [100.00% 00:00:00/00:00:00]Restoring Services on the installed systemls: cannot access whatever.iso: No such file or directory

Argument “” isn’t numeric in division (/) at/usr/sbin/mylivecd line 244.Created ‘whatever.iso’ (0,000 bytes) in 00:14:25
This happens if you try to add too much to your ISO. Mylivecd command can
create an ISO of a maximum size 4.3 GB (single layer DVD size). If you want to
remaster your installation, you will have to exclude some data from it. Now, if you
have few partitions and you only want some of them added, you can exclude the
rest of them by adding them to the nodir part of the command.
Let’s see…
[andrzejl@wishmasbell ~]$ dfFilesystem Size Used Avail Use% Mounted on/dev/sda1 25G 19G 5.1G 79% //dev/sda6 9.9G 8.8G 1.1G 89% /home/dev/sda7 37G 35G 895M 98% /media/Disk_1/dev/sda8 37G 33G 2.4G 94% /media/Disk_2/dev/sda9 20G 9.9G 8.9G 53% /media/Disk_3/dev/sdb1 74G 26G 44G 37% /media/Disk_4[andrzejl@wishmasbell ~]$
All I want in my iso is my / and my /home and I want to skip all the rest of the
partitions…
The remastering command will now look something like this (all on one line):
mylivecd xz nodir^/whatever1/whatever2/,^/media/Disk_1/,^/media/Disk_2/,^/media/Disk_3/,^/media/Disk_4/ tmp=/whatever1/whatever2/ md5sum ufs unionfs /whatever1/whatever2/whatever.iso
As you can see, I have excluded 4 partitions.
The rule of thumb for adding new exclusions is (all on one line):
,^/where/is/it/mounted/
mylivecd xz nodir^/whatever1/whatever2/,^/where/is/it/mounted/ tmp=/whatever1/whatever2/ md5sum ufs unionfs/whatever1/whatever2/whatever.iso
If you want to exclude just one user’s home from the entire /home partition, add
(all on one line):

Remaster YOUR PCLinuxOS Installation
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,^/home/oneuser/
mylivecd xz nodir^/whatever1/whatever2/,^/home/oneuser/ tmp=/whatever1/whatever2/ md5sum ufs unionfs/whatever1/whatever2/whatever.iso
If you want to exclude your entire /home partition, add ,^/home/(all on one line):
mylivecd xz nodir ^/whatever1/whatever2/,^/home/ tmp=/whatever1/whatever2/ md5sum ufs unionfs/whatever1/whatever2/whatever.iso
After properly adjusting your command, you should be able to create a good
working ISO. Try it in VirtualBox before you burn it to the CD/DVD. Sometimes,
the remaster process creates an unusable ISO, and I wouldn’t want you to create
a whole bunch of coasters before you get it right.
Now to get the md5sum file:
I assume that you created the ISO in /whatever1/whatever2/whatever.iso
location.
Issue these commands then:
cd /whatever1/whatever2md5sum ./whatever.iso > ./whatever.md5sum
This will create the whatever.md5sum in the /whatever1/whatever2 folder. The file
will contain the checksum of your ISO.
Example:[andrzejl@wishmasbell whatever2]$ cat ./whatever.md5sumd784fa8b6d98d27699781bd9a7cf19f0 ./whatever.iso[andrzejl@wishmasbell whatever2]$

What if your command line contains spaces?
If you have partitions or folders that contain spaces, you will be interested in this
“special case” scenario. Say, for example, you have the following partition:
/dev/sda7 37G 35G 895M 98% /media/Windows 7

If you want to exclude this mount point from the remastering process you need to
add \ before the space in the command like this:
nodir ^/whatever1/Windows\ 7/
Otherwise, you will receive a FATAL: Too many commandline arguments
error.

Remaster YOUR PCLinuxOS Installation
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Posted by ferry_th, August 22, 2012, running Openbox.

mailto:pclinuxos.mag@gmail.com
http://csolisphotography.com/iso/Updated-SF-E17.iso
http://csolisphotography.com/iso/E17-BlackMyst.iso
http://csolisphotography.com/iso/barebones-laptop.iso
http://www.opensource.org/
http://pclinuxos.com/?page_id=7
http://www.linfx.com


PCLinuxOS Magazine Page 40

by Paul Arnote (parnote)

Ever since the Document Foundation forked
development of OpenOffice to LibreOffice, the
development team has forged steadily ahead with
improvements to the OpenOffice code base.
Initially, most improvements were to clean up the
code by removing unused sections of code that still
existed, removing outdated and seldom used
functions, and improving the structure of the
remaining code.
Now, several releases later, the LibreOffice
development team has hit full stride. With the August
2012 release of LibreOffice 3.6, there are many
enhancements to the open source office suite that
has become the favorite of office suite users around
the world.
Below is a rundown of many of those
enhancements. To update your LibreOffice
installation on PCLinuxOS, simply rerun lomanager
and follow the prompts. New features and
improvements that were labeled as being exclusive
to either Windows or OSX users have been omitted.
You can view the entire list of features and
improvements here.

Featured Updates
• Support for color scales and data bars. Import from
.xlsx and import/export from/to .ods in ODF 1.2
(extended). Warning: Some limitations still apply
which will be fixed in 3.7.0.
• Added Word Count to status bar.
• PDF Export with Watermark option.
• 10 new Impress master pages.
• Support for importing Office SmartArt.
• Import Filter for Corel Draw documents.

New Writer Features
• Format paintbrush can now differentiate character
automatic formating applied to paragraphs from
those applied to text portion inside the paragraph.
• Support for contextual spacing.
• VML import now handles lines, rotations and flips.

• DOCX import now handles GetExpression and
SetExpression fields.
• RTF/DOCX import/export handles document zoom
settings.
• Pressing "Ctrl+[" will decrease or "Ctrl+]" will
increase the font size of the selected text,
respectively. (Note that this function is not available
for all localizations but will soon be updated to offer
full support to all.)

• Updates to Word Count. Added Word Count to
status bar. Fixed two miscounting bugs.
• Table AutoFormats now record the following table
level properties: Break, Keep with next paragraph,
Repeat heading, Allow table split across pages,
Allow rows to break across pages, Merge adjacent
line styles, Table shadow.

LibreOffice 3.6: New Features Galore
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• Shows Text Boundaries depending on the choice to
display unprintable characters.
• Support for importing Office SmartArt.
• Extension of label definitions with form (paper,
page) size. Labels which are not centred on the form
are created correctly.
• All 1700+ predefined label definitions have been
modified to include the form size and obsolete
definitions have been removed.
• Recalculation of label positions on the form. Label
definitions with gaps between labels that are wider
than the right margin now produce correct
documents. Existing user defined labels are
automatically extended with form size.
• The form size can be entered/modified in the
wizard dialog.

New Calc Features
• "Ctrl+D" fills down in more familiar ways, filling with
contents of the cell above if no cell is selected, and,
filling down multiple cells with larger selections.
• New option to specify a custom sheet name prefix
in new documents.
• Merge cells option added to rightclick menu.
• Sheets can now be hidden and/or shown by using
the sheets tab context menu.
• Improved error message for invalid sheet name.
• Export conditional formatting to .xlsx.
• Improved CSV file import, including: handle lines
with more than 64k characters, differentiated
different error messages, better handling of broken
CSV files where generator didn't follow RFC 4180

quote rules, import numbers in scientific notation
without having to check "import special numbers,"
better initial default separators, comma, semicolon
and tab.
• Added a "Save cell formulas instead of calculated
values" option to CSV export.
• New spreadsheet functions as defined in ODF
OpenFormula: DATEDIF, IMTAN, IMSEC, IMCSC,
IMCOT, IMSINH, IMCOSH, IMSECH and IMCSCH
• Added support for field items in cells.
• Calc now allows sorting of data from the autofilter
menu.
• Calc now supports allowing pasting only text,
value, or formula from the context menu.
• Detailed configuration options for formula
calculation. You can now configure the reference
syntax for builtin function: INDIRECT.
• The limitation of 3 sort entries has been removed.

• Default number of sheets for new spreadsheets
has been changed to 1.
• Support for X errorbars in scatter and bar charts,
importing and exporting to .xls and .ods when using
ODF 1.2 (extended).
• Support for color scales and data bars. Import from
.xlsx and import/export from/to .ods in ODF 1.2
(extended). Warning: Some limitations still apply
which will be fixed in 3.7.0
• New dialogs for conditional formats to support color
scales and data bars.

New Impress Features
• Added widescreen format for Impress slideshows.
• Impress now correctly detects the external display
and puts the presenter console on the local display.
• 10 new Impress master pages.

LibreOffice 3.6: New Features Galore
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New Math Features
• Format dialogues (Font, Font Size and Spacing)
and the Symbols dialogue (Tools > Catalog) now
have a button linking to Help.

“Other” New Features
• Basic IDE: Docked Object Catalog pane.
• Filters: ODF Export now comes with a "ODF 1.2
Extended (compact mode)" that gives better
interoperability with older consumers of the Open
Document Format.
• Added Lanczos algorithm for resizing of images.

• Macro recording can be activated with a separate
option: Tools > Options > General > Enable macro
recording.
• Support for Japanese postcard paper size in all
applications.
• Recent Documents list is updated on Save, Save
As and Close.
• Allow for editing of readonly documents.
• Added "Support for assistive technology tools" to
installation process.

New GUI Features
• Rulers are now much cleaner and more
lightweight.
• New Splash Screen.
• A redesigned "About" dialog for a cleaner look.
• New artwork for the Start Office.

• Clicking the ">>" overflow button will not show
toolbar options anymore. The full options can be
shown by rightclicking the toolbar.
• GTK themes are now able to render background
gradient.
• GTK themes now have a way for tab prelight
rendering.
• Writer and Calc now use split color buttons making
it possible to apply the last used color with one
mouse click for font, background, border and
highlight colors.
• GTK theming is implemented for fixed lines and
frames.

LibreOffice 3.6: New Features Galore
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• Support for Trinity Desktop Environment
integration.
• Dictionary choice removed in spellchecker when
there is only one dictionary active.
• Zooming now is based on a geometric progression.

New Localization Features
• Implemented locale dependent date acceptance
patterns for input of incomplete dates. This prevents
erroneous detection of dates in Calc and Writer cell
inputand CSV file import.
• Added enMW locale data.
• Added myvRU locale data.
• Improved language tools (spellchecker, thesaurus
and hyphenation patterns): updated ptBR
spellchecker, updated Swedish spellcheck
dictionary, updated French spellcheck dictionary
and thesaurus, updated Czech thesaurus, greatly
improved German language tools with over 30,000
new words added to the German spellcheck
dictionary and over 7000 new symbols added to the
German thesaurus, hyphenation patterns are also
improved, substantial improvements to the Danish
spellchecker and thesaurus.
• The default locale is now the default locale of the
operating system.

New Performance Features
• Substantially improved simple .doc/.docx import.
• Large document scrolling/relayout/interactive
editing improvements.
• Large autocorrect lists handled around twice as
fast.

• Improved performance for pivot tables in Calc.
Refreshing of pivot table should be 3550% faster
than 3.5. In addition, the memory footprint of the
pivot table is greatly reduced.
• Improved performance of raw cell value import
from .xlsx spreadsheets.
• Improved performance of merged cell and matrix
range import from .ods files.
• Embedded HSQLDB databases are now size
minimized before being saved because Base uses
"CHECKPOINT DEFRAG" instead of
"CHECKPOINT". This means that the space
occupied by deleted rows is really freed up.

It's easier than E=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...

Want to keep up on the latest that's
going on with PCLinuxOS?

Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos

LibreOffice 3.6: New Features Galore

http://www.pclinuxos.com
http://twitter.com/iluvpclinuxos
http://www.linuxforum.com
http://www.ibiblio.org


by AndrzejL

I own a few machines. One of them is my main,
everyday machine. Others are my backup machines
that I use when the main machine is doing a heavy
task, or when I cannot access it for another reason.
Sometimes it’s annoying. Really annoying. Why?
Oh, for example, the pidgin config files were not
synchronized between the machines. I added some
contacts to the main machine pidgin configuration
and I never had a chance to set them up on the rest
of my machines. I had a chat or two with a friend,
and the logs were not available on my other
machines, so I could not check the history of the
chat. I changed the configuration of Firefox on my
main machine, and the other machines were not
updated. Same goes for Thunderbird / email
settings and synchronization. Even my folders with
data. It was seriously bothering me. So, I have found
a perfect solution.
It’s extremely simple. Assuming that you have
passwordless authentication working, all you need is
one command. The command should be run on the
ssh client machine. In other words, you should run it
on the machine you want to synchronize files to. It
will connect to the remote SSH server machine and
download the files from it.
rsync avz e sshandrzejl@192.168.0.100:/home/andrzejl/.purple /home/andrzejl/
This command (entered all on one line, with a space
after "rsync," "avz," "e," "ssh" and ".purple") will
connect with login andrzejl to the SSH server
running on the 192.168.0.100 machine and it will
incrementally synchronize the /home/andrzejl/.purple
folder to the /home/andrzejl/ folder on a local

machine. I didn’t add the .purple folder at the end of
the command as the synchronization process will
create it if it’s not there. If I did add it, it would create
/home/andrzejl/.purple/.purple folder.
Now imagine the possibilities. Put that command in
a script and then create an automated job in crontab
so it will be executed every, let’s say, one hour. I did
it here and it works perfectly! Your client
(backup/spare) machine config files will always be
synchronized with your main server machine. Your
data folders can be synchronized between all your
machines. Perfect. That’s what I wanted.
OH BOY! Is this faster than copying the files with
midnight commander. When syncing my pidgin
folder to a fresh install and using mc, it could take up
to 3 hours due to the fact that the logs folder has
almost 60 megs, and it contains over 41,000 small
files. Rsync does it in less than 20 minutes. And,
later it just copies the “new” files thanks to the
“increment” option. So now, it takes several
seconds. Rsync rocks.
If that’s not cool, I don’t know what is.
If You have tightened up SSH server security and
changed the SSH port from the standard use of port
22, you will have to slightly modify the command to
add the port number.
Here is what it looks like (entered all on one line,
with a space after "rsync," "avz," "e," "ssh" and
".purple"):
rsync avz e 'ssh p 20202'andrzejl@192.168.0.100:/home/andrzejl/.purple /home/andrzejl/

Support PCLinuxOS! Get Your OfficialPCLinuxOS
Merchandise Today!

Syncing Files Via SSH Using rsync

http://www.cafepress.com/pclinuxos
http://andrzejl.no-ip.org:10101/wordpress/2011/03/11/what-are-you-running-pclinuxos-on/
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Top Left: Posted by
YouCanToo,
August 10, 2012,
running KDE4.
Top Right: Posted
by T6, August 1,
2012, running
KDE4.
Bottom Left:
Posted by Celchu,
August 17, 2012,
running KDE4.
Bottom Right:
Posted by
cstrike77, August
1, 2012, running
KDE4.

More Screenshot Showcase




